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1. 2uvbeon oto cm.harica.gr
Juvdedpaote otnv oeAida https://cm.harica.gr kat emiléyoupe I6pupatiké Login/Academic Login.
MNavw 6g€La umopou e va aAAagoupe TV yAwooao tne oeAidag.

MAHARICA NI GR

Eloobog

Aev e Aoyapeaoyad
Higxrpovud tayubpoutio

Eruléyoupe wg popéa to AleBveg Naverotiuio tng EANGSocg kot matdue EmBepaiwon/Confirm.

GRNET AAI EmAoyn oikeiou gopéa Gopeic  YTmpeoieg Tekpnpiwan BonBeia EAANVIKG English
o OpooTiovdia EAYTE
%l DeLos
Ymrodour] Tautotroinong kai EEouaioddtnong (AAl)

BpiokeaTe 08 QuTAV T OEAIGA £TTEIDI TTPOOTIGBACTE VO TIPOOTTEAGCTETE LA UTTNPECIT TTOU CUPPETEXE! TNV OpooTTovGia AHAOZ Tou EAYTE. NPoKEIPEvoU va TTpoXwphoETe, Ba
TIpETTEl va EMAELETE Tov OlKelo Gopéa gag ammd TOV TTapakdTw Katdhoyo. MPoaipenkd, WTTOpPETE va aTToBnke0CETE TNV ETTIADYR QUTH, WOTE Va PNV EPWTNBEITE OF ETOPEVEG OUVDEDEIG

oag.
i LigBvEg NavemoThpio g EAMGDOG - |

Amo8rikeuan Tng mpeTiunang: [

Autopata Ba petadepBolpe oe véa oelida dmou Ba mpémel va TANKTPOAOYHCOULE TO GVOpa
Xpriotn/username kat Tov Kwdk6/password Tou I1SpupaTikol pog Aoyaplaopol Kat
natape Eicodo.

’\’8 AIE@NEZ
TTANETIIETHMIO
THE EAAAAOT

& Ovopa xproTn

ﬂ Kwdikog ®

=exdoare Tov KwdIKé oag;



2.

Altnon ya Mponyuevn HAektpovikr Yroypadn

En\éyoupe amnd To pevou ota aplotepd HAeKTpoVIKEG YroypadEg.

= FHARICA

B Dashboard

B eSign Eyypaguy

MoTomomTkd

B Hhextpovikic Yroypapég

B3 Hhiextpovikic Zippayibeg

8  Notonommxa Server

Erttdoyn Tumou MotomnotnTikou

Eridéyoupe Mponyuévn HAektpoviki Yrioypadr > MNa emyelpiosLs ) opyaviopoug (IV+OV) kat
Tatdpe oto kouurni Emhoyn.

Mponyuévn Hiektpovikn Yrnoypaen

MNa 1BuwTeG 1) atopukeg enixelpnoeis (IV)

Motonommiko Mponyuevng Hhextpovikiig Yroypagig yia unoypa@n Emidoyn
eyypagpwv.Mepihaufavel TILAOYN

» Ta mpoownKa cag oToEla
armo

50€ €1o¢g

MNa emyepnoelg 1) opyaviopoug (IV+OV)

Miotomommko Mponyuévng HAexktpovikng Ynoypa@nc yia unoypapn
eyypagwv.Mepaupavet ET“AOYI".
* Ta npoowmxd oag oToxeia

e Ta OTOLXELQ TOU OPYaVIOLLOU HE TOV OTOLO EXETE EVEPYT)
guvepyaola

Awpeav



MOALG BeBatwBol e otL EAEXONKe tatae Emdpevo.

Ma emyelpnoelg 1) opyaviopoug (IV+OV)
ST 1 |—'rl1 Evn A

ng Hiextpoving Yroypagng yia unoypagpn
( EmiAéxOnke )

Awpeav

YLLEN

4. EmAoyn Kol LETaPOPTWOoN eyypadwy TAUTOMOINoNG

JTa OTOLXELQ TOU TILOTOTOLNTIKOU TOU TIPOKELTAL VO EKS0BEL, EKTOG ATIO TO OVOUATEMWVUMO LOG,
XPELALETOL VO UTIAPYEL KOl £VAL ETILITAEOV OVASLKO XAPAKTNPLOTIKO.

e EmAéyovtag tnv TUnki nepintwon, n HARICA Ba mapdyel autopaTa, €va LovadLko
10yndlo avayvwploTtiko to omnoio Ba eloayxBel ota otolyela Tou TLoTOmMoLNTIKOU pag. To
HOvo Tou Ba xpelaotel, elvat va eTiAéEoupe avapeoa oto AgAtio Tautotntag (AAT) ) to
AlaBatrplo kat to omoio Ba peTadOoPTWOOUUE WG SIKALOAOYNTIKO.

@ Em\éEre Tov TOmo ekakpiBwaorg TautéTTag mou Ba
XPT|OLOTIO|OETE

I AL Tunua nepinmwen (mpoteiveral) I ‘

Aey £yl Amoloy E15KG A upmepthipur cTaSEpd

apamplou/APQM) oTo N

(VWIPLOTLED (QUOLKOU
OINTIKD HOoU.

mpoowou (Ap. TAUToTNT

Xwpa SaAOYTITIKLIV

Greece v

Timog Eyypagpou

ApiBuoe AshTiou TouTOTNTAE (AAT) v

Em TUTIO EYYpapoU

ApBuse Aeitiow Tautdmmrag (AAT)
ApBuoe AaPatmplou

R Tiwfrm neninrem R

@ AveBdote Ta £yypaga tautonoinang

EmiAoyn apxciou

e e meplntwon mou eMBUMOVLE TO TILOTOTIOLNTLKO HaC VA EXEL EVal OTABEPO OVAYVWPLOTLKO, TO
omoio Ba dnuootevetat pali pe TNV umoypadr Lag, LTOPOUHE va ETUAEEOUE T oUVOETN
TepiMTWon Kat oto €(60¢ oTabepoU avayvwpLoTIKOU GUGCLKOU TIPOCWTIOU EXOULE TLG
emhoyég tou AgAtiov Tavtotntag (AAT), AwBatnpiov kat Dopoloywko Mntpwou (ADM).
Mo KaBe pia amno tig Stabéoipeg emAoyEg, Ba xpelaoTel vol TANKTPOAOYOOUE TOV aplBuo
otaBepol avayvwpLoTikou .. AA123456 yio AAT Kal val LETAdOPTWOOULLE TO AVTLOTOLXO
SKaloAoynTLKO.



Béln va mpocBicw Eva OTaBE pd ovayVWPLOTIEG (PUCIKOY TpOOLTIoU (AD.
Tautdmrag/Mapommplou/ADM) oo MITTOMONTIKG o,

EmuiéETe Timo eyypdpou

ApiBudc AzAtiou TouToTnTac (AAT) -

Ermb£Ete elbog oTafepol avayViopLOTIKOD QUEIKOU TIROTUIToU

Apipog Aeiriou Taundmnrag (AAT)
ApiBude Aapornplou
ApiBuog Popohoyikol Mntpuwou [ADM]

Greece v

ApiBudc Eyypagpou

FupmAnpwoTe Tov apiBuo syyoaoou

€. Tivbeon elDAS ﬂ

v

To MOTOMONTIKG Pow Ba MERLEKEL TTANpopople; TTou mapEyovTal amd v EBvik

Ymnpeola Efaxplfwome TautdtnTag e xwpag pou (elD).

@ Avepaote Ta £yypaga Tavtomnoinong

EmiAoyn apxeiov



MPOZOXH! 3tnv £181kN mepinmtwon mou enthééoupe tov AptOpud Mopoloyikou Mntpwou (ADM),

€KTOC Ao Tov aplduo otabepol avayvwplotikol tou Ba mAnktpoAoyriooupe (9Prdo AOM), Ba
xpelaotel va emilé€oupe éva emmAgéov SikaloAoyntikod wg enionpo £yypadd Tautonoinong Kat to
omoio Ba petadopTWOoOoUE.

B. ZovOemn neplmrwon (

Gédw va mpooBiow éva oTabepd avayvipLoTED QUokod Tposwmou (Ap.
Tavtémrac/Aafatnplow/ADM) oto MoTonomTikd pou.

Emii£ETe Timo eyypapou
ApiBuce Copoioyikod MnTpwou (ADM) w
Hwpa SaloAoyTTKLY

Greece W

ApiBusc Eyypagpou

IupmAnpluoTe Tov opiBuo eyypdpou

Egpodooy enmthéiate Tov ApiBud Qopoioywol Mitpuou, mapakahoijie emhEETE Kal
£va EMloN Mo EYYPQEP0 TAUTOMPOTWiac.

Tomog Eyypadgpou

ApiBpog AzATiou TouToTnTOg (ALT) w

EmA£ETE TOmo ey ypagou

ApBudeg Askriow Tavtdtruac (AAT)
ApiBuog Aaparmplou

@ AveBaaote Ta éyypaga Tautonoinang

Emihoyr apxeion

Irovapete Kol avefacte To Aektio Tautdtnrag cag (2 dbew)

Mmopelte va aveBdoeTe To £y ypapd oag ot eva £lTe mEpLoTdTEpa apyela. O emTpeEnGReEvoL
TUmoL apxElwy slval .pdf, jpeg. .png, zip. To péyedog Tuw apyelwy Sev npéne va unmeppalvel ta
2MB

AvepaoTe To £yypapo ApBpol Qopoloyikol Mntpuiou oag

Emidoyr apxeiou



5.

3TN GUVEXELA KAVOULE EAEYXO OV TO OVOUATEMWVUMO HAG TALPLATEL AMOAUTO LIE TO EMIONUO
€yypado TAUTOnoinNonG ou €XOUUE LETAGOPTWOEL KOL KAVOUUE TLG amapaitnteg Slopbwoel.
MPOALPETIKA, UMOPOULE VA ELOAYOULE TO OVOLATEMWVU O AG KL OE XOPOKTAPES TN TOTUKAG LAG
vYAwaooag cupdwva tavta Ue To enionuo £yypado tavtonoinong. Enetta, emiléyoupe Emdpevo.

@ EmBeBawwoTte 611 Ta mpoownika oag orowyela elvar owotd
OUITATIPWHEVA
Ta mpogwnikd povw grosla [Ovopa ko Emevupo) slval cwoTd kol avToTooly anoAuta

(yplupa-npog-ypdupa) pe autd oro enlonpo éyypape efakplBwang TautdmTac mou

avefaoo

‘Ovopa (ue Aatvikols YapaxTipes) EmiBero (pe Aarvikols YapakTipeg)

o Bélw va ElTdyw TO OVoud Kal To EMIBETS pou OF XOpoKTPES TNV TOMKTG LoU YAWGoac,
¥ | AnoGéyopal OTL oL XOpaKTHPES MOU CUTAT]
wdll ! Of (

Yptyipa) fE autd oto enlonpe Eyypage sfaxplPwong TauTdTnTag,

v anéhuta (ypdupa-ripog-

< Mpenyouusvo Emopevo

Erloyn opyaviopou

EmAéyoupe av emBupoUpe va epudavileTal 0TO MLOTOTONTIKO LA, TIEPOV TOU OPYAVIOHUOU LG
(Aristotle University of Thessaloniki), To tuiua (Opyavwtikp Movada) oto omolo avriKoU e Kol
natape Emopevo.

EmAéEte Tov opyaviopo oag
@ International Hellenic University
ITOLXEia TOU OpYavVIOMOU

Nopym enwvupia

International Hellenic University - IT Center

Nopym smwvupia (Tomkn MNwooa)
Agbvig Maveruomuo g EAAGSog

Xwpa
GR

MoéAn

Thessaloniki

IMoAn (Tormkn MNoooa)
Begooalovikn



Ertidoyr pebodou tautomnoinong

Mo tnv pebodo tautomoinong, Exoups SVO EMAOYEC yLa TLG OTIOLEC AKOAOUBOULE TIG AVTIOTOLXEG
obnyiec.

NPOZOXH! Ta éyypada mou Ba petadoptwooupe otn HEBodo Tautomnoinong mpeEneL va ival o
Hopodn .pdf

A. Emkowwvia pe tnv e§uninpétnon xpnotwv HARICA.

@ EmAéEre pla and tig mapakatw peBddoug ekaxplpwong
TQuTOTNTAS

A. ©a nBeha va emrovuwvnoEeL 1) efunmpéetnon xpnotwy Tng HARICA (
pall pou ([amarreitan puokn napouaia)

H efurmpemon xpnotwv Ba emkowvwvrioer pall oag oyetikd pe ) dwadikaola
efaxplBwaong TautdmTag.

B. ®a yxpnowonomow pa unapyouoa Eykexpuuévn Hhektpovikn v
Yroypapn

H emkolvwvia pe tnv e€untnpétnon xpnotwy thg HARICA mpoUmnoBEtel tn dpuaoikn oag moapouasia ya
TNV TAUTOMOLNOoN HE Kiat o’ TG TP aKATW ETUAOYEG:

1. Quowkn napoucia oto TuRua MAnpodopikig (Kévipo Alayxeiplong Aktuou) g
MavemotnulounoAews oag, Ladl Le enionuo £yypado Tautonpoowrniag (AoTUVOULKN
TautotnTa N dapatrplo) n

2. EktUnwon YrmevBuvng AnAwonc, cuunmAnpwaon Kat emkatpornoinon og KEM f aAAn
dnuoota apyn (OXI amoé gov.gr) ylo To yvroLo tng uroypadnc.




B. Xpnon volotapevng Eykekpipévng HAektpovikng Yioypadng (m.x. €€ anootaosws
nAektpoviki urtoypadn A miotoronTiko Eykekpipévng HAektpovikn g Yrioypadng o
KpurttoypadLkr) GUOKEUR).

AUTOC 0 TPOTIOC A SLEUKOAUVEL TtepLoodTEPO £hpOoOV SLOBETOUE EVEPYO TILOTOMOLNTIKO KABWG
8¢ Ba amattnBel puoikn mapouacia yla TNV TAUTOMOINOH HAG.

MPOZOXH! EAv tnv mponyoupevn ¢opd ou KAVALE altnon XPNOLOTIOL|CALE TNV
oUYKeKPLUEVN HEBOSO, auth tn dopd dev Ba epdaviotel otig Stabsotpeg emhoyég. Baost
KOVOVIOUWV arayopeVeTalL 2 ouvexOueveg GopEC va yivetal aitnon xpnoLlonolwvtag tn
OUYKEKPLUEVN HEBOSO eCakpiBwaong TautoTNTAC.

B. @a ypnowonowmow pua umdpyovoa Eykekpyuévn Hiexktpovikn (
Ynoypagpn

1. Katepaote v aitnon Eykekpipévng Hhektpovikng Yroypaprig
Aitnon Eykexpipévou Miotomomtikou yia Hiektpovikr Yroypagn

2. ZUUIMANpWOTE TIS QITAITOUMEVES TTANPOQopies

3. Yrnoypadte v aitnon pe v undpyouoa HAeKTpovikn
Yroypagn

4. AveAOTE TO UTIOYEYPAUEVO EYYPAQO

D_1-33 HARICA Qualified Certificate Request for
eSignature cm.harica.gr v1.0 EL.pdf

EmAoyn apxsiou

Ermhéyoupe EmOpevo.

(]



7. TMpoemokonnon altnong
EAéyxoupe Ta oTolela TG aitnong kat emAéyoupe otL Slafacaue kat anodexopacte toug Opoug
Xpriong kot tig Atadikaoieg kal MoAttikn Miotonoinong tng HARICA. Enetta, eruléyou e Emdpevo.

EAéyEre v almon nipv v kataBéoete

Tunog Motonomtikou Alapkela Ynmpeolag
Advanced eSignature OV 2¢ém

Trotyela Tuvbpounm)

Ve | —

Aentopépeleg Opyaviopou

Nopn enwvupia: Arctotie Uniseraty of Thassaond,
Opyavwrud) Movada, OU: T Cevter

MéAn: Therisons

xdm R

Ynoompitika Eyypaga
ElSog Eyypagou Apyela

NTR

AmnobewTd Befalwong ouvepyaoiag
HE ToV Opyaviopd

‘Eyypago Tautomnoinong « Sl pdf

MéBobdog EEaxplBwong
MéBobog Apxela

PhysicalPresence

O/H . (To évoud cag e Aatvikolg Yapaxktmpeg) Sniwvw o6t suaaca

xalL anobéyopal, pe v untofolr) Tng altmong, Toug Opoug Xpnong kat Tig Aradikaoleg xat
’n Molrikn MoTtonolnong ¢ HARICA. EnutAgov, cuvaviy atn Xphon kai anoBnxeuon Twy

nANpoYopLwY autold Tou arrfiparog, and v HARICA, clpgwva pe ™ Afhwon

IBuwTikdTa AsSopuéviov



Anpoupyila 1OlwTtkou kKAeldLoU kot CSR

‘Exoupe tnv emloyr va dnpoupyrnooupe To apxeio CSR oto mpoypappa epLynong Hag
XPNOLUOTIOLWVTOG TN duvatotnTa autopatng dnuwoupylag. H emthoyr Autopatn dnuoupyia CSR
artattel va erihé€ou e tov TUTO/éyeBog Tou KAELSLOU Kal Vo 0ploOUE £va KwSLKO TIOU TIPETEL VOL
Bupopaote KoOwe Ba TpooTaTEVEL TO LOLWTLKO KAELSL TOU mLoTOmONTIKOU pOG. MATtApe TO KOU T
Anpoupyia KAELSLOU Kal KATAOECH QULTAHILATOG.

KataBeom atmparog

O Tieivat to CSR;

|< Avtoparn Snuovpyia CSR ) 1’] < AwoTte To 51k6 oag CSR >

Ba dnpovpynoete £va 15uwTikd KA1 otov mhonyo oag kat Ba yiver autoparn napaywyn tou CSR.

O AlyépiBpog © Méyebog kAeibiov
RSA (mpoemiheypévo) v ‘ 2048 (mpoemheypévo) v .
Ewoayete éva kwbwod

‘“ ........ ® “

‘ ........ ® “

Katavow kat anodéxopat 6Tt 0 OUYKEKPIpEVOS KWwIKOG eival oy andAutn katoxr pou kai n HARICA
Sev £xeL npooPaoct) ot AUTOV TOV KWEIKG.

NapalaBn WOLwTtikol KAELSLOU
Kavoupe mapalaPr] Tou 6LwTKoU KAELSL0U KL, 0T CUVEXELQ, TATAE TO Kouuni Emlotpodn otov
Dashboard.

MNPOZOXH! MNatwvtag to kouuni NapalaPn, Oa katéPel oto pdkeho ARYPELS (amd poemiloyn) Tou
uToAoyLoTr pag éva apxelo pe ovopa privateKey.pem. Oa mpémnel va Slatnpriooupe pe aochalela
TO mapanavw opxeio kat tov KwdLkd o opioape oto mponyoupevo BrApa kabwg Ba ta
XPNOLHOTIOINooUHE apydTepa oTnV Sladikacio LETATPOTIAG TWV apxeiwy .pem o .pl2.



H almon oag karaxwpnBnke enttuxwg

To buwTikd kheldl éxel Snuovpyndel kal n napayyeAla Tov MOTONOWTIKOU Cag

ExEL kataywpnBel
©a ypewaotel va ylver
* - Napahafn Tov WuwTxod cag KAELS0.

MPOZOXH: Auth etvair n povabum gopd nou propeite va o napakdfere xau
Sev Ba propeite va avaxthoete 1o WbuwTikd cag kKAeSI apydtepa.

0

10. 'EAeyyoc aitnong

H attnon pag, xpetaletal va eykplBel anod toug urnteUBuvoug eAéyyou (validators) Tou dopéa pag,
oL oroiot Ba kavouv TNV emaAnBeucon Twv otoleiwyv pe Baon ta gyypada mou HeTAdOPTWOALLE.

Motonomtikd 0f ekkpepdTnTa

m o ’.ﬂmur&wn. 1evipyua

11. ‘Eykplon aitnong
MOALG oAokAnpwBel 0 Edeyxog Ba eldomonBoupe pe PAVURA NAEKTPOVIKOU TaxudpoEiou, OTOV
SPUHATIKO LOG AOYOPLOCHO, VLA VA TIPOXWPICOUE 0TNV TapaAa B TOU MLOTOMOLNTIKOU UOG,.

Eykupa moTomomnTikd

m ov C=GR L=Thessaloniki,0... ’_s,;

12. Mapalafn MNMotononTikou
Kavoupe AYn twv apxeiwv PEM kat PEM bundle.



MoTonomTikod b4

i Aerropgpeies L ANYM O Avakinonm A EiSomomoelg ™ Tuvadayn

Mnopelte va napahdfete 1o Motonomikd oag o SIPOPES HOPPES, avahoya HE TIG QVAYKES 0ag.

=) (=) Cm) ()

Tumixr popgn

Turtn popgn Turuen Suabua KEIEVOL

MEEVOU HopT

Edv 1o 16wt KAebi Tou T
DER (CA} ki va Ta Ei0ayeTE ot
PEM bundle, Te

https:f

13. Metatponn apxelwv .pem o€ .p12
Oa npémel va petaBoupe otnv oeAida https://www.harica.gr/el/Tools/PemToP12, yia va
petatpéPoupe os popdn .pl2 ta apyeia .pem nouv napardapape pall He To ISLWTIKO KAeLdL
(privateKey.pem) mou €xoupe anoBnkeloeL Tponyoupuévwe kata t Stadikacia tng aitnong.

e EmAéyoupe to apyeio PEM.

MeTaTtpotriy apxeiwv .pem og.p12

Oa XpeIaoTETE TO MOTOToINTIKG, To 1B1LTIKG KA£IBI Kai Tnv Apxr Exdoanc.
H Siadikaoia PeTarpoTific Twy apXeiwy TTpaypaToTToIEiTal aTTOKALIOTIKG OTov TTAoNYG oag kai kaviva oToixeio dev amrooTéAAeTal oTnv HARICA
MioTomoinTKG (.pem)

* Enthoyr) apxeiov ) OCPIEAB06765F43B282FCC 1 166C TIAL pem

e EmAéyoupe o LELWTIKO KAeLSL (privateKey.pem) mou amoBnkeloape vwpiltepa KoL ELOAYOUUE
Tov Kw8LKO Tou elyape oploel yla T ELWTIKO KAELSL.

1B1wTIKS KAEIBI (.pem)

* EmAoyr} apxeiov ) privateKey (1).pem

Kwdixdc idiwTikol kA&idiol

L mepimrrwan ou 1o 15wNKS oag khaidi AEN mpooTtaréueral pe kwdiké TpéoBaonc, agrioTe To Mapammavw Tedio kevo

e EmAéyoupe to apxeio PEM bundle.

Apyr Exboong (.pem)
{ Emiloyn apxeiov ) DCYZEABDSTESFAIB282FCC1166CT3A2 (1).pem

MoTomoinTikd Apxric Exdoang (CA) i PEM bundle



OpiZoupe ToV KWSLKO TTOU Ba TPOOTATEVEL TO TEALKO TILOTOTOLNTIKO OLG KAL TIOTAUE OTO KOU UTTL
Anuoupyia.

MPOZOXH! O kwdKOG MPEMEL va €XEL TOUAAXLOTOV 9 XOPOKTHPEG.

OpioTe kwdIKO apygiou .p12

Anpovpyia

Av n Stadkaoio oAokAnpwOnke emtuxwg, Ba katéBeL oto pakelo AfPeLg (amo poemiloyr)) Tou
umoloylotr pag éva opxeio pe ovopa HARICA pkes12.p12.

B HARICA pkes12,p12

14. Ewoaywyn Motomolntkou

o VoL ELOAYOUE TO TILOTOTIOLNTLKO Ttou TtapaAdfape (apxelo HARICA pkcs12.p12) otov
UTIOAOYLOTH HaG, AKOAOUBOUE TIG TP AKATW 08NYLEC:

Elcaywyr TpoowrnikoU riLotonotntikov ota Windows

Anapaitntn npolmobeon elval va £XOUE TO aApXelo TOU MLOTOMOLNTIKOU UE KATAAnén pl2, to
ormoio mpogku e amo Tt HETATPOTT TwV OpXEiwv .pem og .p12 oto nmponyolpevo Brua 13. Mo va
£LOQYOUE TO TILOTOMOLNTIKO pag ot Windows, kdvoupe SUTtA6 kALK oTo apxeio Tou
TILOTOMOLNTIKOU Kol akoAouBoU e Ta Brpata otov 0dnyo.

EvoAAOKTIKA, XpnoLlomoloUpe Tov TAonyo Internet Explorer, 0mwg BAEMOUUE TTAPAKATW.

Brpa 1: Artd to Baotkd pevou tou Internet Explorer mnyaivoupe Epyaleio/Tools > EniAoyég
Inernet/Internet Options > Meplexopevo/Content > Miotonowntika/Certificates.

= *
O~ e ﬁ )

Print »

File »
Zoom (100%) >
Safety ¥
Open with Microsoft Edge Ctrl+Shift+E

Add site to Apps

View downloads Ctrl+J

Manage add-ons
F12 Developer Tools
Go to pinned sites

Compatibility View settings

Internet options
About Internet Explorer




Internet Options ? >

General Security  Privacy Connections  Programs  Advanced

Certificates —

Use certificates for encrypted connections and identification.

Clear 551 state Certificates | Publishers

AutoComplete
= AutoComplete stores previous entries Settings
= on webpages and suggests matches
for you.
Feeds and Web Slices
E Feeds and Weh Slices provide updated Settings
a content from websites that can be
read in Internet Explorer and other
programs.

oK Cancel Apply

Brpa 2: Stnv Kaptéla Npoowriké Ztoweio/Personal matdpe Etcaywyrn/Import.

Certificates >

Intended purpose: <All> w

Personal  Other People  Intermediate Certification Authorities  Trusted Root Certification) * | *

Issued To Issued By Expiratio...  Friendly Name

Export... Remaove Advanced

Certificate intended purposes
Client Authentication, Secure Email, Document Signing, 1.2.840.113583.1.1.5

View

Close

Brpog 3: Matdpe Endpevo/Next.



&% Certificate Import Wizard

Welcome to the Certificate Import Wizard

This wizard helps you copy certificates, certificate trust lists, and certificate revocation
lists from your disk to a certificate store.

A certificate, which is issued by a certification authority, is a confirmation of your identity
and contains information used to protect data or to establish secure network
connections, A certificate store is the system area where certificates are kept.

To continue, didk Next.

Cancel

Brpoag 4: Sto enodpevo napdbupo, matdue Avalritnon/Browse kal avalnTOUE TO TIPOCWITLKO HOC
TILOTOTIOLNTLKO OTO XWPO amobrikevuong Tou. Katomwy matdpe Avotypa/Open.

Inueilwon: Av to motonownTikd pag 6ev epdaviletal oto dakeAd Tou, emheéyoupe OAa ta
apxeia/All files ano tn Aiota mavw and to kouprni Avotypo,/Open yia vo to SoUE.

X

€ & Certificate Import Wizard

File to Import
Spedfy the file you want to impart.

File name:

Note: More than one certificate can be stored in a single file in the following formats:
Personal Information Exchange- PKCS #12 {PFX,.P12)
Cryptographic Message Syntax Standard- PKCS #7 Certificates (.P7B)

Microsoft Serialized Certificate Store (.55T)

Mext Cancel



& Open X

1 ; » ThisPC » Downloads v | D [ Search Downloads
Organize = New folder = @ @
s MName Date modified Type Size
yp
3 Quick access
B Desktop ~ Today (1)
& Downloads _ﬁ haricacert(1).p12 17/12/2021 3:19 pp Personal Informati... TKB

v Last month (5)

=] Pictures M=) Vpeythini_dilosi_NDA_GR.docx
- [ Test_PDF_signed.pdf

[ Test_PDF.pdf

_é haricacert.p12

E TeamViewer_Setup_xBd.exe

El Documents

2021 11:38 mp Microsoft Word D... 24 KB
/ 1132 Microsoft Edge P... 98 KB
Sereenshote F202111:31 mp Microsoft Edge P... 15KB
o in 10:27 mp Personal Informati... 7KB
Odnyac fkdoan " - T A
2021 3:40 pp Application 34.037 KB
Odnyog motom

[ This PC

_J 3D Objects % [ 3

File name: | haricacert(1).p12 ~ | || All Files (**) ~

Open 1v Cancel

BApag 5: Alvou e TOV KWOLKO TIOU TIPOCTATEVEL TO CUYKEKPLUEVO apXELO Kall

emAéyou e Znpeiwon tou WLwTtikol KAeLSLoU we e§aywytpouv/Mark the private key as
exportable kot ZupnepiédaBe dAeg tig puBuioeig/Include all extended properties. Ensita
natdpe Enépevo/Next.

€ =¥ Certificate Import Wizard

Private key protection
To maintain security, the private key was protected with a password.

Type the password for the private key.

Password:

[Jpisplay Password

Import options:

Enable strong private key protection. You will be prompted every time the
private key is used by an application if you enable this option.

ark this key as exportable. This will allow you to back up or transport your
eys at a later time,

Protect private key using virtualized-based security{(Mon-exportable)

ndude all extended properties.

Mext Cancel

BApag 6: EmAéyoups Autopatn erttAoyr) TOU ILoTononTikov GpakEAoU e BAoH TOV TUTIO TOU
ruotonowntikol/Automatically select the certificate store based on the type of certificate.
Moatdpe Endpevo/Next kot TEAog/Finish.



& &% Certificate Import Wizard

Certificate Store

Certificate stores are system areas where certificates are kept.

Windows can automatically select a certificate store, or you can specify a location for
the certificate.

utcnrrlaticallyI select the certificate store based on the type of certificate
(O Place all certificates in the following store

(e shore:

Personal

Browse...

€ &* Certificate Import Wizard

Completing the Certificate Import Wizard

The certificate will be imported after you dick Finish,

You have specified the following settings:

g ey Ry e Smi=s b Automatically determined by the wizard

Content PFX

File Mame Vecf2\dfsYwinHomethome \tzakirae \DownloadsYharicacert(1).
< >

Finish Cancel
e

BrApag 7: TéAog, Ba epdaviotel Eva pivupa ou Ba pag mAnpodopel OTL TO MLOTOMOLNTIKO LG
EYKOTOOTABNKE EMITUXWC.

Certificate Import Wizard x

o The import was successful,




Brpoag 8: TéAog, matdpe KAeiowo/Close yia va emiotpéPoupe oto mapdBbupo Emhoyecg
Internet/Internet Options kat OK yia va eritotpgdoupe oto Baoko mapddupo tou Internet
Explorer.

Certificates *

Intended purpose: =All= ~

Personal  Other People  Intermediate Certification Authorities  Trusted Root Certificatior| * | *

Issued To Issued By Expiratio...  Friendly Name
5| Dokimastikos Dokimastikidis HARICA Institutional ...  17/12/2023  <Monex

£ >
Import... Export... Remaove Advanced

Certificate intended purposes
Client Authentication, Secure Email, Document Signing, 1.2.840.113583.1.1.5

Internet Options ? *

General Security Privacy Content Connections Programs Advanced

Certificates -

Use certificates for encrypted connections and identification.

Clear 55L state Certificates Publishers

AutoComplete

AutoComplete stores previous entries Settings
on webpages and suagests matches
for you,

Feeds and Web Slices

< | Feedsand Web Slices provide updated Settings
Y7F7) content from websites that can be

read in Internet Explorer and other
programs.

f

oK Cancel Apply

Elcaywyr] Tpoowrnikol riotonotntikol o MacOSX

Kavte SUTAG KALK OTO QpXELO TOU TILOTOMOLNTIKOU e KOTAANEN pl2, To omolo mpogkuPe amo tn
UETATPOTI TWV apxeiwv .pem oe .pl12 oto mponyoLuevo Brpa 13. MANKTpoAoyrnoTe Tov KWOLKO
TPOOTACLOC TOU TILOTOMOLNTIKOU.



15.

oy Enter the password for “PCertificates.p12":

Password: |

[ | Show password

|Cance|_|| oK |
‘_m

Av n gloaywyn ATav ENLTUXNAG, TO TILOTOTOLNTLKO o0 Ba epdaviletal otn Alota Twv
TotononTIkwy tou Keychain.

Yroypadn pe Adobe Reader

TéAog, umopoupe va cupPoudeutoupe Tig odnyieg yia xprion tou Adobe Reader yia tnv mpoaoBnkn
gyKeKpLUEVNG Wndlakng umoypadng os apyeia pdf




